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The walkthroughs are divided into 
four sections: Windows, Office, Internet 
and Creative, so whatever your area of 
interest there’s sure to be something here 
to interest you. We’ve also included a few 
Windows Vista tips to help you make the 

most of Microsoft’s new operating system.
We’d love to know what you think of our first 

electronic booklet, and whether you’d like to see 
us produce more e-magazines in the future. 
Simply log on to the Shopper forum on our 
website at www.computershopper.co.uk or send 
an email to letters@computershopper.co.uk.
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Make sure you’re working on the right version of a file with Windows Briefcase

 T he deadline looms – a project is due, or a club 
newsletter needs to go to the printers. You’re 
working on files at home, at work or on a 

notebook. Things can go drastically wrong, as files are 
left behind or the wrong version is taken from one PC 
to another. This is where Windows Briefcase helps.

The Briefcase feature checks specified folders and 
files between a computer and a Briefcase file. There 
are two ways to use it. You may have two computers 
that are often in proximity, such as a desktop PC and 
a notebook. The two computers need to be connected 
either through a network or directly via a cabled or 
wireless connection. Alternatively, you can use 
Briefcase to carry files from one PC to another using a 
USB flash drive, floppy disk or other removable media. 
We’ll show you how it works in Windows XP.

1 Right-click on the desktop on your notebook 
and select New, Briefcase. The new empty 

Briefcase appears on the desktop. If you want to keep 
the Briefcase in any other location, create it there. If 
you’re going to carry folders between two computers 
on a USB flash drive or similar, create the new 
Briefcase on the first computer and when you’ve 
copied files into it, move it to the flash drive.

Depending on how your notebook and desktop PC 
are linked, access the folders or files on the desktop 
PC and drag them to the Briefcase icon on your 
notebook. Any subfolders will also be copied. If you 
right-click and drag a folder, you’ll see the additional  
‘Make a sync copy of type’ option. This lets you 
specify file types that you want copied; for example, a 
folder might contain Word documents and image 
files, but you’ll want just the Word documents copied.

2 Work on files in the Briefcase as you would 
normally. Later, you can connect the desktop 

PC and notebook again, or insert the USB flash drive. 
Open Briefcase and select Update All from the 
Briefcase menu. Alternatively, select specific folders or 
files within the Briefcase then choose Briefcase, 
Update Selection.

HOW TO…
Use Windows Briefcase

WINDOWS BRIEFCASE

3 Files in both locations are compared and a 
list showing the differences between both is 

displayed. The icons down the middle show the 
actions the software intends to take when the 
comparison is complete. Right-click on any file to 
change the intended action or to take no action at all.

If you delete a file from the Briefcase, it will 
also delete the file on the PC with which you’re 
synchronising. When you’ve finished checking the 
intended actions and making any alterations, click 
on Update to complete the update.

1

2

3

3 Floating toolbars can get in the way. Instead, 
drag the toolbar to the edge of the screen. 

When the palette gets close to the screen edge, it will 
automatically stick to the side. There are just two 
more things that we need to do in order to make it 
behave the way that we want. First you need to right-
click on the toolbar and select Always on top, so the 
toolbar isn’t obscured by application windows. Then 
you need to select Auto-Hide, so that when it isn’t 
being used the toolbar slides out of the way. 

 F requently used programs, as well as frequently 
accessed folders and files, are quicker to access 
from a shortcut on the Windows desktop. But 

after a while, the Windows desktop begins to look a 
mess. You could move these shortcuts to the taskbar; 
the quickest way is to drag the icon straight on to the 
Quick Launch area. 

However, it doesn’t take long to fill this up. 
Unless you increase your taskbar’s height so that it 
has two rows of buttons, or even three, there’s not 
much more you can do – or is there? Windows XP 
still has the custom toolbars feature of previous 
editions but, like so many other useful Windows 
tricks, this feature seems to have been forgotten 
over time.

1 Open Windows Explorer, right-click on a 
clear area in the right-hand pane and select 

New, Folder. Give the folder a name; we called ours 
My Toolbar. Move all the shortcuts, documents, 
applications and folders that you want on the custom 
toolbar into the folder. Shortcuts are easiest since you 
won’t have to reorganise your hard disk, but you can 
mix real folders, files and shortcuts.

2 Right-click on a blank area of the taskbar. From 
the menu that appears, choose Toolbars, New 

Toolbar. Navigate to the folder you created in Step 
1. When you’ve chosen your folder, Windows creates 
a new area on the taskbar with the same name as 
your folder. If you click on this, a pop-up menu lists 
the folder contents. You can open and launch any of 
these just by selecting them.

If this doesn’t work, right-click the taskbar and 
untick Lock the Taskbar before trying again. You can 
pull the toolbar free of the taskbar and position it 
anywhere on the screen. Move the cursor over the 
toolbar. Click and hold the left mouse button down. 
The cursor changes into a four-headed arrow. Drag 
the cursor over the desktop and let go. It will appear 
as a floating toolbar. 

Are you struggling to make sense of your messy desktop? In this guide we 
explain how to keep all those handy shortcuts accessible but out of sight

HOW TO…
Create a desktop toolbar

SHORTCUTS

2

3

1
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Are the colours produced by your printer different to those you see on your 
screen? Here we explain how to use Adobe Gamma to adjust your set

 M ost monitors leave the factory with high 
brightness and contrast settings and a 
brilliant blue-white tone. However, this 

setup doesn’t do a lot for accuracy when reproducing 
colours, so colours in a printout may not be the same 
hue as the colours you see onscreen. 

To correct this, you need to calibrate your monitor 
and assign a new colour profile, which is used to 
correct the display’s colours. If you have Photoshop 
Elements or another Adobe product installed on your 
PC, you can calibrate your monitor for free using the 
Adobe Gamma control panel.

1 In Windows XP, you’ll find Adobe Gamma in 
the Control Panel or on the Start menu. 

Alternatively, look in C:/Program Files/Common Files/
Adobe/Calibration, and double-click on the .cpl file. 
Start with the Wizard mode. In the first step, choose 
a new profile name. Then set the monitor contrast to 
maximum and reduce the brightness so the central 
dark-grey square in the window is just visible.

2 Ignore the next step prompting you to identify 
your monitor’s phosphors. However, the 

gamma correction step is important. If the View 
Single Gamma Only box is ticked, you’ll see a single 
square with a slider. Move the slider to make the 
brightness of the centre box the same as the striped 
surround. You’ll find it helps if you squint. However, 
it’s better to untick the box, so you can adjust the 
Red, Green and Blue gammas individually.

3 In the next step, you’re asked to pick a 
hardware white point. You can choose a value 

from the drop-down menu. Alternatively, click the 
Measure button to judge the white point manually. 
You should train your eye to recognise the colour 
shifts. Keep your eye on the centre square and click 
repeatedly on the left-hand square. The centre square 
will get more and more blue until the left-hand 
square disappears. Click repeatedly on the right-hand 

HOW TO…
Calibrate your monitor

ADOBE GAMMA

square until it disappears, and the centre square will 
get warmer. Once you’ve trained your eye using this 
method, use the left and right-hand squares to adjust 
the middle square until it is a neutral grey, neither 
too warm nor too blue. To set this as your white 
point, click the middle square. To cancel the whole 
procedure, press Esc on your keyboard.

Go straight to the final screen. This has Before 
and After buttons so you can see what difference the 
calibration process has made. Usually, you can expect 
to see the screen go a little darker and a lot less blue. 

1

3

2

HOW TO…
Create a screensaver
Although there are a lot of creative screensavers 
available for download, nothing beats the personal 
touch. Why not use the pictures you have on your 
PC as a screensaver instead? Open the Display 
Properties dialog box by right-clicking on an empty 
space on your desktop and selecting Properties. Go 
to the Screen Saver tab. In the Screen saver drop-
down menu, select My Pictures Slideshow. Click on 
the Settings button then on Browse to find the 
folder containing the images you’d like to use. There 
are other settings here you can change, such as the 
length of time for which each photo is shown. When 
you’ve finished, click OK. In the Display Properties 
dialog box, click on Preview to see how your 
screensaver looks.

HOW TO…
Make a short cut
The function keys, labelled F1 to F12, are useful for 
doing certain tasks quickly. In any program press F1 
to see the Help menu. Press F12 in most programs 
for the Save As dialog box. In web browsers pressing 
F5 refreshes the page. In Word, use the F2 key 
instead of cut and paste. Highlight the text, press 
F2, click where you want the text to appear and 
press Enter. 

You can assign your own tasks to a Function key 
in Word. Go to Tools, Macro, Record New Macro. 
Click Keyboard and enter the Function key you want 
to assign. To change from a function that might be 
already assigned, 
click Assign. 
Perform the task 
and stop the 
recorder. Now 
when you press 
that function 
key in Word, it 
will perform 
that task.

HINTS & TIPS 

HOW TO…
Take a screenshot
The Print Screen key (sometimes labelled PrtScn) on 
your keyboard, usually located above the Insert and 
Delete keys, is a handy way to take a picture of 
what’s happening on your desktop. Pressing it won’t 
initially seem like it’s done anything, but a replica of 
your current screen has been placed in the Clipboard.

Run your favourite image-editing application, 
such as Windows Paint, and press Ctrl-V to paste 
the image. You’ll notice that the whole desktop will 
be pasted, so you can either save the entire image 
or crop the section that you’re interested in.

Alternatively, if you’re only interested in one 
screen, you can take a picture of only that 
application. Select it 
with your mouse and 
press Alt-Print Screen. 
When you paste it 
into your image-
editing program you’ll 
only get a picture 
of the application 
you selected.
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list. By default, backup images are saved in the My 
Documents\Microsoft USB Flash Drive Backup folder. 
This can be changed from the Settings tab, which 
we’ll look at below.

3 Restoring an image to a flash drive is just as 
simple as backing up. Select ‘Restore files from 

my computer to a Flash Drive’, then choose the flash 
drive to which you want to restore the image. Select a 
backup image name from the list on the right-hand 
side of the dialog box. The image will then be copied 
across. To wipe the drive before the image is copied 
across, tick the box next to ‘Clear Flash Drive before 
restoring’. Unfortunately, the program restores 
everything to your flash drive inside a single folder 
with the name of the backup image, rather than to 
separate folders as there were originally on the drive. 
If this isn’t what you wanted, you’ll have to use 
Windows Explorer to reorganise your folders.

4 Go to the Properties tab and click on the Edit 
button to add a label to the flash drive to 

identify it within Windows. That’s not all you can do 
on the Properites tab. Ticking the ‘AutoRun’ box will 
make the flash drive run automatically when plugged 
into a USB port. The option to ‘Include Runtime 
Components with the USB Drive Manager’ adds 22MB 
of code, but enables the drive to autorun on Windows 
computers that don’t otherwise have the necessary 
components to do that.

5 The Manage Library tab works with the drive 
backup images that have been saved on a hard 

disk. There are two buttons at the bottom of this tab: 
one to delete the selected backup image, and one to 
open an Explorer window on it. Each image is actually 
a folder on the hard disk, containing the files from the 
drive in uncompressed form and any autorun details 

 U SB drives, also known as flash drives and thumb 
drives, are now as ubiquitous as floppy disks 
once were. They store hundreds of times as 

much data as the old 31/ 2in floppy disks, and they are 
even easier to use. 

Microsoft’s Flash Drive Manager is a simple 
program that makes working with flash drives even 
easier. With the cost of drives falling all the time, 
many people have several of them, so some way of 
maintaining them and backing them up for security 
is very useful. 

Microsoft’s Flash Drive Manager is not supplied 
with Windows, but it can be downloaded free from 
the Microsoft website at http://tinyurl.com/3r44p. 
After installation, plug a flash drive into any available 
USB port before starting the walkthrough.

1 Flash Drive Manager is designed to handle all 
the kinds of jobs for which you’re likely to want 

to use your flash drive, including copying files, backing 
up and restoring their contents, making a flash drive 
auto-run when plugged in and copying all the 
necessary files for setting up a wireless network.

Go to the Copy Files tab. Click on a drive name to 
select it and a list of folders and files will appear in 
the right-hand column. The file and folder list is live, 
so you can drag files from other folders to the Flash 
Drive Manager pane and vice versa. However, you 
can’t copy files directly from one memory drive to 
another within the manager. 

2 The Backup/Restore tab requires just three 
clicks to create a complete backup of a selected 

memory drive. First, select ‘Back up my drives from a 
Flash Drive to my computer’. Then select the flash 
drive you want to back up, and finally click on the 
Backup button. If you want to overwrite an existing 
backup image, select its name from the right-hand 

4

2

3

1

needed to run the drive image once it has been 
restored to a drive.

6 Finally, we’re at the Settings tab. There are 
three settings at the bottom of this tab. The 

first includes the runtime components needed to 
make a flash drive autorun and is linked with the 
equivalent options on the Properties and Manage 

65

HOW TO… 
Make the most of your 
USB flash drives
Microsoft’s Flash Drive Manager can help you get more out of your portable 
storage devices – and, what’s more, this useful utility is absolutely free 

Library tabs. This is the default setting. The second 
option enables you to enter a minimum amount of 
free disk space on your hard disk, so a backup from a 
flash drive doesn’t fill it. Finally, you can enter a path 
to a folder where you want Flash Drive Manager to 
store flash drive images. Click on the Browse button 
to navigate to your desired folder and then on the 
Save button to save any setting changes you make. 

USB FLASH DRIVES USB FLASH DRIVES

http://tinyurl.com/3r44p
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Once you’ve created your torrent, simply upload it to 
a BitTorrent search site to make it available to others.

1 Open your BitTorrent program and pick Create 
Torrent under the File menu.

2 In the Create Torrent dialog, pick the file you 
wish to create a torrent for, give the torrent a 

name and write a short description.

3 Some BitTorrent programs allow you to choose 
the size of the pieces into which your file is 

split. For most people, the default setting is fine.

4 Make sure that you have associated a tracker 
with your torrent and then press Publish. A 

list of live BitTorrent trackers can be found at 
http://thebeehive.info.

N o-one likes waiting for downloads. Yet even 
with broadband, downloading large files can 
often be frustratingly slow. Here we’ll show 

you how you can get the fastest download speeds 
possible using the BitTorrent file-sharing technology.

A torrent is a small file that describes the file you 
want to share. Most BitTorrent clients can be 
downloaded free of charge and have a function for 
making torrent files. Anyone who wishes to download 
and share the file you are making available will first 
need to download a copy of the tiny torrent file. 

Once you have created your torrent, you must 
upload it to a BitTorrent search website such as 
www.isohunt.com or www.thepiratebay.org. 

The first step in making a file available for other 
people to download is to create a torrent file. This 
describes the location of the file you want to share, 
along with other information needed to download it. 

4

2

3

1

HOW TO… 
Share files using BitTorrent
Get faster downlaods by mastering BitTorrent file-sharing

BITTORRENT

http://thebeehive.info
www.isohunt.com
www.thepiratebay.org


Make the most of Vista’s new interface with our guide to its new features

Microsoft has added some good, sensible 
features to Vista, but it has also given the 
interface a polish. Rather than using the 

processor to do all the work, Vista will offload some of 
the work on your graphics processor, provided your 
graphics card is up to the job. 

To find out if your graphics card supports Windows 
Vista, download the Vista Upgrade Advisor from 
www.microsoft.com/windowsvista/upgradeadvisor. 
If your graphics card isn’t powerful enough, don’t 
worry. You’ll still be able to run Vista, but you won’t be 
able to experience all the new visual effects.

Vista comes with two display schemes: Vista Basic 
and Aero. The Vista Basic scheme is similar to the 
Royale theme that’s included with the latest version 
of Windows XP Media Center Edition. Aero, on the 
other hand, uses what is termed Glass. All windows in 
Aero are semi-opaque so, for example, you can see a 
blurred image of the Recycle Bin on the desktop 
through the menu bar at the top of a window.

If you hover the mouse over a minimised window 
on the taskbar, rather than just showing its name, 
Aero displays a small thumbnail of the window. If you 
have a lot of windows open, this will help you quickly 
find the one you want. The thumbnails also show 
what is going on in the window. So if you’re playing a 
video in Media Player, its thumbnail window will also 
show the video playing.

As in previous Windows versions, pressing the Alt 
and Tab keys lets you scroll through open windows. 
This switcher has been spruced up in Vista and it uses 
the same thumbnails as the ones used on the taskbar, 
making it easier to find the correct window by sight.

But why use Alt, Tab when you now have Flip 3D? 
This new function makes switching between windows 
much easier. Hold down the Windows key and press 
the Tab key, just as you would for Alt, Tab. All open 
Windows will now appear in a curving line, from the 
top left to the bottom right of the desktop, allowing 
you to scroll through open windows in a 3D format. It 
looks great and makes switching between open 
windows quite exciting.

HOW TO…
Experience Aero and Flip 3D

WINDOWS VISTA

▲ Aero’s Glass display allows you to look through 
menu bars to see what’s beneath

▲ Alt Tab now shows thumbnails and even full-motion 
video

▲ Flip 3D throws your windows into 3D space to make 
it easy to find the one you’re looking for
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WINDOWS VISTA

HOW TO…
Use Quick Launch
The Quick Launch bar to the right of the Start 
button is a great time-saver for accessing frequently 
used applications. But under Vista there’s an even 
faster way to use it. 

The first 10 applications can be launched by 
pressing the Windows key and the numbers 1-0 on 
the keyboard, so Windows-3 launches the third 
application, for example.

HOW TO…
Speed up your system
One of the downsided to all Windows Vista’s 
flashy new features is that it’s much more 
demanding on your hardware. If you find that Vista 
is running a little slowly, ReadyBoost is a new, 
painless upgrade that will help. Just plug in a USB 
flash drive and choose ‘Speed up my system’ from 
the AutoPlay menu. Vista will now use the flash 
drive as additional memory space, resulting in 
speedier operation.

ReadyBoost will improve performance only 
when there’s little or no physical RAM free, and the 
PC would otherwise begin to use the hard disk 
swapfile heavily. However, ReadyBoost is currently 
no substitute for real RAM, and you’ll need a 
ReadyBoost-compatible USB drive.

HOW TO…
Find the expanded 
options list
Right-click on a file in Windows Explorer and you’ll 
be presented with a short list of common 
operations. You can bring up an expanded list of 
options by holding down the Shift key while right-
clicking, which includes additional items such as 
‘Add to Quick Launch’ or ‘Pin to Start Menu’.

13JULY 2007 • COMPUTER SHOPPER
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Layout tab and set the Header’s distance from the 
top of the page. Printers don’t print right up to the 
edge, so we need to choose a good safe distance. A 
value of 1.5cm should be fi ne for most models. Word 
users can now skip to Step 5.

3 In WordPerfect, page headers are inserted 
within the main text margins. First, open the 

Page Setup dialog box. After setting the paper size to 
A4, set the top margin to the distance we want 
between the top of the sheet and the header. A value 
of 1.5cm is about right for most printers. 

In WordPerfect, you have to rely on the height of 
the header we’ll insert next in order to put the text 
the right distance from the top of the page for 
windowed envelopes.

4 To create a header in WordPerfect, go to Insert, 
Header/Footer. The options in the dialog box 

can be left at their defaults as we’re creating Header 
A. This inserts a header area where we can enter the 
header contents. Because this header lies within the 
page margins, however, we need to juggle its height 
to push the text below to the right height for the 
windowed envelope. We can do this using the Header/
Footer Distance button on the Header/Footer toolbar. 
This is where a little trial and error is needed. Print a 
test sheet, measure the distances and adjust the 
Header/Footer Distance value accordingly.

5 Once your page margins and 
headers are set up correctly in 

Word or WordPerfect, we can type in 
an address block below it. The number 
of lines that will fi t within the 
envelope’s window depends on the size 
of the window and the font being used. 
It’s usually fi ve or six lines. 

In our example, we’ve typed these in 
as Name, Address Line 1, Address Line 2 

and so on to remind us later that all six 

 H eaded stationery makes business and personal 
correspondence look more professional. All the 
main word-processing programs offer 

adjustable page margins, headers and footers, but 
may go about it in different ways. Our walkthrough 
shows you how it’s done in Word and WordPerfect X3. 

If you work for a company with its own headed 
paper, you’re already halfway to creating professional-
looking correspondence, and you can skip to Step 5. 
Once your headers are established, we’ll show you 
how to position the recipient’s address so your letter 
looks its best in a windowed envelope. Windowed 
envelopes are widely available in good stationery 
stores, and save you having to print and attach 
separate labels or, worse, write addresses by hand. 

Finally, we’ll show you how to add footers so the 
pages of longer letters are numbered. 

1 We’ll start with Word. WordPerfect users can 
skip to Step 3. In Word, page headers lie outside 

the page margins. We need to choose a top margin 
that positions the text of the letter underneath the 
window in the envelope. We’ve measured this at 
5.5cm from the top. Go to File, Page Setup. On the 
Paper tab choose A4 from the Paper size menu. If you 
don’t use this, Word may default to the US Letter size, 
which will mess up the measurements. On the 
Margins tab, set the Top margin to 5.5cm.

2 If you’re not using headed stationery already, 
create a page header. From the View menu 

select Header and Footer. If you insert a 
great deal of text or a large graphic, 
there’s a danger that the header 
content will start pushing down the 
main body of the text below it. In our 
example, though, the 5.5cm value 
we’ve chosen for the top margin gives 
plenty of room. 

The last job here is to return to 
the Page Setup dialog box. Go to the 

4

2

3

1

lines must be used in order to push the main text of 
the letter down beyond the bottom of the window. If 
you don’t need all six address lines, type Returns 
instead to leave the remaining lines blank.

6 Finally, if your letters are likely to run over more 
than one page, you can use a Footer to display 

both the page numbers and the number of pages in 
total. For example, in Word, you use the View, Header 

65

HOW TO…
Set up a letterhead
Headers and footers make letters look more polished. Here’s how to set them 
up and use windowed envelopes so you don’t need separate address labels

and Footer command again. This time scroll to the 
bottom of the page to edit the Footer area. Now type 
Page and leave a space. Then click on the Insert Page 
Number button on the Header and Footer toolbar. 
Leave another space, type ‘of’ and enter another 
space. Click on the Insert Number of Pages button. 

In WordPerfect, the Header and Footer toolbar has 
a single drop-down menu for numbers; you need the 
Page Number and Total Pages options.

as Name, Address Line 1, Address Line 2 
and so on to remind us later that all six 

EXPERT TIP
Instead of typing ‘Address Line 1, Address Line 2’ and so on into your address block, use the mailmerge fi elds and then save the document as a template for mailshots.

STATIONERY STATIONERY
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Put your tables in a manageable state so they are easier to read

 T he ability to create a table in Word is an 
immensely useful tool. By putting information 
in tablular format, you can make it easier to 

read and manage. However, once a table gets so large 
it is no longer contained on one page, it starts to take 
on a life of its own. Here we show you how to make 
your tables more manageable in Word 2003.

1 If your table has grown so long that it’s over 
two or more pages, you can have the column 

headers appear automatically on subsequent pages. 
Select the row of headings in your table, and the first 
row of your table. From the Table menu, select 
Heading Rows Repeat. To see the changes made to 
your table, the document needs to be in Print Layout 
view. Select this option from the View menu. This 
works only for natural page breaks in your document. 
If you insert a manual page break Word won’t repeat 
the column headings.

2 A workaround to this problem is to split the 
table. To do this, place the cursor in the table at 

the beginning of the row you would like to become 
the first row of your new table. Go to Table, Split Table. 
You can now create a page break between the two 
tables. Insert a new row in the second table, and copy 
the column headings from the first table into the 
blank row.

3 As well as splitting a large table across pages, 
Word may also split a row over two pages if it 

is particularly large. To stop this happening, highlight 
all the cells in the table. Go to the Insert menu and 
select Table Properties. On the Row tab, untick the box 
next to Allow row to break across pages. This applies 
the action to all the rows in the table. If you want to 
apply this to just one row, highlight only that row 
before opening the Table Properties dialog box.

To make it easier to read a large table, you can use 
colour. Open the Styles and Formatting panel from 
the Format menu. Under Pick Formatting to Apply, 
find your table style; it might be the default Standard 

HOW TO…
Manage large tables in Word

MICROSOFT WORD

Table. Click on the down-pointing arrow next to this, 
then on Select all 1 Instance (assuming there is only 
one table in your document). Click on the menu again 
and select Modify. In the Apply Formatting To box, 
select Odd row stripes. Click on the Shading Colour 
tool to choose a colour.

2

3

1

HINTS &TIPS

HOW TO…
Use Go To
The Go To command in Word is a convenient way to 
move around large documents quickly. You can use 
it to move to different pages, section breaks, 
bookmarks, footnotes and even comments. The 
latter is useful if you’re working on a large 
collaborative project. To see how it works, open a 
document with comments inserted. Press Ctrl-G on 
your keyboard. This opens the Find and Replace 
dialog box with the Go To tab already selected. 
From the menu on the left, select Comment. On the 
right, select a reviewer from the drop-down list or, 
to go directly to a comment, say the tenth 
comment from the one you’re on, enter +10.

HOW TO…
Enable Office-featured links
When you’re looking for help in any Microsoft 
Office program, it’s important to try as many 
sources as possible, so you should make sure Office 
is looking online and at the featured links. The 
latter provides the most up-to-date help and 
information Microsoft provides. Featured links are 
based on the most frequently asked questions 
received by Microsoft.

Open your Office program. Go to the Help 
menu and pick the Microsoft Office Help option (it 
has F1 next to it). Go to the bottom of the Help 
panel that appears, under See Also, and click on the 

HOW TO…
Find expanded options
The Group and Outline features in Excel’s Data 
menu simplify how data in a spreadsheet is viewed. 
These features group together selected rows and 
columns, and indicate the grouping with a plus or 
minus sign to the left or above the top of the 
worksheet. To hide the grouped data, click the plus 
sign. To see those rows or columns again, click the 
minus sign. This is useful if, for example, you don’t 
need to see all the data in a table but just the 
subtotals. The data is there, but you see only what 
you need at a glance. You can do this manually, but 
if you have subtotals in your table, go to Data, 
Group and Outline, Auto Outline.

Online Content Settings link. Check there is a tick 
next to Show Microsoft Office online featured links.
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down the right-hand side of the page indicating any 
formatting changes and deletions. If it doesn’t open 
in Print Layout view, go to the View menu and 
select that option; otherwise, you won’t be able 
to see the notations.

Insertions – text that has been added – will be 
shown in red with a red underline. This isn’t ideal, 
though; there isn’t any way to see which document 
the additions or deletions come from. However, if 
you’re going to accept or reject alterations 
individually, it shouldn’t be too much of a problem.

4 You may think that merging the file into the 
current document would get around this. We’d 

expect that selecting this option from the Merge 
menu in the Compare and Merge Documents dialog 
box would result in a document showing only the 
alterations made in the second file. However, the end 
result is exactly the same as if you merged the two 
into a new file. All changes from both documents are 
shown, with no way of telling from which document 
the addition or deletion came. 

However, you could compare the documents, 
rather than merge them. To do this, you need to open 
the Compare and Merge Documents dialog box again, 
and this time tick the box next to Legal blackline. The 
Merge button now changes to read Compare.

5 The best way to see how the Compare tool 
works is to use it. If you named your test 

documents as we did, open your Original document. 
Then open the Compare and Merge Documents 
dialog box, making sure the box next to Legal 
blackline is ticked. Click Compare, and a new 
document is generated. You might expect to see the 
Later Versions document shown, with all the parts 
that differ from the Original document highlighted. 
In fact, it is the opposite. 

 W ord documents are often passed around 
several people for proofreading, editing or 
other contributions. The document can end 

up being very different to its original incarnation. If 
you use Track Changes in Word, you can see at a 
glance what another contributor has done, but what if 
they switched it off? For these occasions, Word has a 
tool called Compare and Merge Documents. In Word 
2002 and 2003, you’ll find it in the Tools menu. This 
tool isn’t as straightforward to use as it could be, 
though, so here we’ll explain how to make it work for 
you. We’ve used Word 2003.

1 Pick a document to practise on. For example, 
copy an original file, and then a later, edited 

version of that file. If you don’t have anything that fits 
the bill, take an existing document and save it under 
two different names. Make some changes to the 
second file and save them. In our case, we have an 
Original.doc file and a Later Version.doc. We want to 
merge the Original file with the Later Version 
document to create a single document containing all 
the information from both. We’ve got the Original 
document open. From the Tools menu, select 
Compare and Merge Documents.

2 In the dialog box that appears, click in the Look 
In box to find the file you want to merge into 

your current document. In the bottom right-hand 
corner of the dialog box is a Merge button. Click on 
the down-pointing arrow just to the right of the 
button. Select the appropriate action from the 
menu that appears. We’ve chosen Merge Into New 
Document. This way, the two files being merged 
are kept intact.

3 The new document opens in Print Layout view, 
with the Reviewing toolbar open and notations 

4

2

3

1

This is confusing, because it highlights an addition 
in the Later Version as a deletion in the comparison 
document. If you want to compare an updated 
document with the original, you need to open the 
updated document and then use the Compare and 
Merge Documents tool.

6 If you don’t need to see the formatting changes 
made, untick the box next to Find Formatting 

in the Merge and Compare Documents dialog box. It’s 
also a good idea to turn this off when you’re merging 
comments and changes from several documents into 

65

HOW TO…
Compare and merge 
documents
Sharing documents is convenient, but it helps to see the changes made to a 
file by comparing it to a previous version – and it’s easy to do in Word

one document, as Word can store only one set of 
formatting changes at a time. It is also possible to 
compare the formatting of two different portions of 
text in a single document.

Highlight the first section. From the Format menu, 
select Reveal Formatting. An example of your 
formatting will appear under Selected Text in the 
Reveal Formatting panel. Tick the box next to 
Compare to another selection. Select another 
section of text to compare it to; any differences 
between the two will be displayed under 
Formatting differences. 

MICROSOFT WORD MICROSOFT WORD
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HOW TO…
Use Excel on two monitors
Excel is set by default to open a new spreadsheet 
within the same window. This is great most of the 
time, and is the best way to work where formulae 
are used to share data between spreadsheets, or are 
copied from one sheet to another.

However, if you have two monitors and want to 
work on two spreadsheets at the same time, it’s 
more convenient to have one sheet on one screen 
and the other displayed on the other screen. 

The easiest way to do this is to hold down the 
Shift key, then click on Excel’s program entry in 
the Start menu. This will start a second instance of 
the program. Open your spreadsheet in here, then 

HOW TO…
Convert forms to text
Many people work with a number of different forms 
in Word, such as leave requests, bookings or 
feedback forms. Sometimes it can be easier to work 
with the answers provided on these forms if the 
form is converted into an ordinary text document.

There’s a quick and easy way to do this. First 
make sure you unprotect the form by choosing 
that option from the Tools menu. Next select the 
whole document. Don’t do this by running the 
cursor down the form and highlighting, even if it 
is a short form. Instead, choose Select All from 
the Edit menu or press Ctrl-A. Once the form is 
highlighted, press Ctrl-Shift-F9. This converts the 
form into a text document.

you can move it to the other monitor just as you 
would any program.

HOW TO…
View Excel 
spreadsheets
If you don’t have a copy of Excel, or you want to 
send information in an Excel spreadsheet to 
someone who doesn’t, help is at hand. Go to 
www.microsoft.com/downloads and get a copy of 
Excel Viewer 2003. This will let you open, view and 
print Excel workbooks, but you won’t be able to edit 
them. However, the contents of the workbook can 
be copied and transferred to another document. 

The latest version of Office has new file formats. 
If a document is saved in these formats, you won’t 
be able to open them in an older version of Office. 
There’s also a compatibility pack available that will 
allow you to open these files, and you’ll need to 
install this after you’ve installed the Viewer.

As you organise your document in this way, you’ll 
notice that your outline fleshes itself out as you 
continue to work on it. At the end of the process, 
you’ll have a set of headings that define the 
document’s scope and structure and tell you exactly 
what you have to write and where it’s supposed to go. 
To fill in the body copy itself, create a new blank line 
under a heading and select Body Text from the Levels 
drop-down menu.

 T here’s nothing worse than staring at a blank 
sheet of paper, your fingers hovering two 
inches above your keys as your brain spins 

around in hopeless circles. However, you’re also in 
trouble if you find yourself bashing out 5,000 words 
only to realise you’ve gone off at a tangent because 
you didn’t have a clear plan at the start.

Word’s Outline mode can solve both these 
problems. In three simple steps, we can show you how 
to turn your raw ideas into a structured document 
that eventually almost writes itself.

1 Imagine you have to write an article about 
choosing a digital camera. You may not know 

where to start, but when you use outlining it doesn’t 
matter. You can approach the subject from any angle 
and sort out the structure later. First open a new 
blank Word document. Switch to Outline view via the 
View menu and start typing in words and phrases as 
they come to mind. Enter these like bullet points with 
a word or phrase per line. 

2 On the top toolbar there’s a drop-down menu 
showing the ‘Level’ assigned to each line in 

your document. Because we’ve typed our text into a 
blank document in Outline view, it has all been 
entered at Level 1 in the outline. A section of text 
marked as Level 2 will appear as a subheading to the 
Level 1 text above it. In our example, we want to 
make Noise reduction a subsection of Noise. To do 
this, place the cursor anywhere within the text that’s 
going to be changed into a subheading and select 
Level 2 from the drop-down menu.

3 You can change the hierarchy of a lot of 
headings by using keyboard shortcuts. Press Tab 

to demote a heading and Shift-Tab to promote it. You 
can drag headings and their sub-headings up and 
down the hierarchy. To do this, click the symbol to the 
left of the heading. Now drag the whole lot up or 
down. A horizontal arrow shows you where it will be 
inserted when you release the mouse button.

HOW TO…
Brainstorm in Word
Unlock your creative side with the help of Word’s Outline mode

MICROSOFT WORD
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www.microsoft.com/downloads
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A free online service can help you create definitive list of the DVDs you own

 H ow many DVDs do you own? If you find it 
hard to keep track, DVDSpot can help. Its free 
service allows you to keep a catalogue of all 

the DVDs you’ve watched, or want to watch. It also 
contains a picture of the DVD’s cover, a synopsis, 
runtime and other details including a cast list.

To get started, go to www.dvdspot.com and click 
on the Register link in the top left-hand corner. You’ll 
need to sign up, then click on the link in an email sent 
to you to activate your account. 

1 To add a DVD to your catalogue, enter its name 
in the DVD search box in the top right-hand 

corner. It is also possible to search using the title’s 
UPC number (the universal product code found on 
North American barcodes). When you’ve entered your 
search you’ll get a list of possible matches. If you click 
on a title in the list, you’ll be able to see additional 
information about the DVD, as well as DVDSpot 
statistics such as the number of other members who 
own it, watched it or are planning to buy it one day. 

To add the movie to your collection of owned 
DVDs, click the Go button in the My Collection 
section. If you want to add it to your wishlist or 
watched list, click on the menu next to ‘Add this DVD 
to my’. These options to add the DVD to your 
catalogue are also available on the first search page.

2 Next, enter some details about your DVD. 
When you’ve finished, click Save. In the future 

you’ll be able to make a note of when you’ve watched 
this DVD again, and keep track of it if you lend it to 
someone. If you want to make any changes to the 
information you entered for this title, click Edit. This 
screen also allows you to choose to keep the DVD 
entry private.

3 Click on the Front Page tab at the top of the 
screen, and then on the Manage Membership 

button. Here, you can make your entire collection 
private, as well as make alterations to your profile. 
You may already have a list of your DVDs on your 

HOW TO…
Catalogue your DVDs

DVDSPOT

computer. If it is in a word-processor file, open it and 
select Save As from the Edit menu. Save it as a .TXT 
file. If it’s a spreadsheet, save it as a .CSV file. Back at 
the DVDSpot My Spot page, click the Import from File 
button. Scroll to the bottom of the page, and click on 
Browse to find your file. Then click Start. 

2

3

1

the one you want to remove and hit the Delete key 
on your keyboard.

It is possible to create keywords for any website 
you have bookmarked as well. To do this, open the 
Bookmarks Manager again. Right-click on the relevant 
link and select Properties. Enter something suitable as 
the keyword, for example you could use CS for the 
Computer Shopper website. 

 F irefox is known for its tabs, which have proved 
so useful even the latest version of Internet 
Explorer uses them. However, hidden away in 

Firefox is another useful feature that will undoubtedly 
find its way into other browsers. Keywords are an easy 
and convenient way to conduct searches straight 
from the location bar, and here we show you how 
they work.

1 Firefox has a few keywords set up. These may 
vary slightly, but most installations of Firefox 2 

use google, wp, dict and stock. Type google into the 
location bar, then a space, and follow that with the 
search term. For example, entering ‘google computer 
shopper’ (without quotes) will open a Google page 
showing the results from that search. The first two 
or three results will be for this magazine’s website. 
Follow the stock keyword with the stock symbol 
you want to search on. 

2 You can set up your own keywords. To show 
how this works, we’ll set a keyword up for 

IMDB, the movie database. Go to www.imdb.com. 
Right-click on the search box at the top of the screen. 
From the menu that appears, select Add a keyword for 
this search.

In the dialog box that appears, enter a name for 
your keyword; to make it easier to recognise the 
keyword in future, use the name of the website. Then 
enter a keyword. In our example, this is the letter i. In 
future, if we want to search the IMDB, say for a movie 
character, we just need to enter ‘i darth vader’ in the 
location bar rather than having to go to the website.

3 You may want to get rid of a keyword you 
created and possibly use a different keyword 

for that site. Go to the Bookmarks menu and 
select Manage Bookmarks. Make sure Bookmarks 
is highlighted in the left-hand pane. In the right-hand 
pane, scroll down to the bottom where you’ll find 
the keywords created using the process. Click on 

HOW TO…
Use Firefox keyword searches 
Using keywords in Firefox improves the speed and efficiency of searches. 
Here we explain how to access information online in a smarter way

FIREFOX
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www.dvdspot.com
www.imdb.com


24 COMPUTER SHOPPER • ULTIMATE HOW TO… VOL 8 25JULY 2007 • COMPUTER SHOPPER

IN
TER

N
ETIN

TE
R

N
ET

HINTS & TIPS

HOW TO…
Spot search trends
It’s possible to see what people the world over 
are searching for with www.google.com/trends. 
The software isn’t complete; as yet, it looks at only 
a portion of the searches undertaken on its main 
Google search engine. These are extrapolated to 
indicate trends and popularity the world over. Enter 
up to five terms, separating each with a comma, to 
see how many Google searches have been done on 
them. You could enter your name and the names of 
some friends to see who’s most popular on Google. 
For example, pit Jade and Jodie against each other 
by entering Jade Goody, Jodie Marsh. Apparently 
Jodie wins hands down, except for a brief moment 
in April 2006 when Jade criticised Britney Spears.

HOW TO…
Export contacts
If you’ve been using your free Hotmail account for 
a while, you will have built up a lot of contacts. It is 
possible to transfer these to the address books in 
other programs. In Hotmail, click on Contacts, Print 
View. Highlight everything, including the top line of 
Name, Email, Phone. Select Edit, Copy and open a 
blank spreadsheet. Select Edit, Paste. Check there 
are no empty rows, and all the email addresses are 
under E-mail and not Name. Save it, and in the Save 
As Type box select the option that contains CSV. You 
can import the file into the contacts of programs 
such as Outlook.

HOW TO…
Turn off HTML
Although messages that use HTML look more 
dynamic, there are good reasons for sticking with 
plain text when you’re writing emails. Plain-text 
messages are smaller, so they’re faster to send and 
receive; HTML messages are a convenient way for 
viruses and Trojans to travel, and your message may 
not look the same on the computer to which it is 
sent. In OE, go to Tools, Options, Send and select 
Plain Text under Mail Sending Format. 

If you’re using Thunderbird, go to Tools, Account 
Settings, Composition & Addressing. Untick the box 
next to Compose Messages in HTML format. In 
Hotmail, open a new blank message. Click on the 
Tools menu and again on Rich Text Editor ON to 

switch it off. All new messages will open with the Rich 
Text Editor switched off until you turn it on again. In 
Google Mail open a new blank message and click on 
the Plain Text link to achieve the same result.

▲ Use all the contacts you’ve built up in Hotmail by 
copying them to your PIM address book

▲ Keeping your emails plain and simple makes them 
easier to read and safer to send

it, open this page and click Delete this list. To start 
a new list, click on My Lists to return to the main 
to-do list page.

You may have noticed that there are lists that 
can be viewed by anyone on the main page of this 
website. If you’d like yours to be publicly viewable, go 
back to the to-do list page, click Share, scroll down 
the page and select that option.

 T he world is so frantic now that we’re all doing 
about half a dozen things at once. Trying to 
keep on top of it all is a logistical nightmare. 

We have to-do lists scribbled on pads or the backs of 
envelopes, which are easily lost. The to-do lists in 
programs such as Outlook allow you to do a lot more, 
but you’re not always at your computer.

There is a third option. You can keep your to-do 
list online using a service such as Ta-da Lists 
(www.tadalist.com). This way, you can access your 
to-do list from any computer with an internet 
connection. Tie it in with Ta-da List’s sister site, 
Basecamp (http://basecamphq.com/demos/welcome) 
and you can keep any project, from a fundraising fête 
to a holiday, organised and running smoothly.

1 First you need to register. Click on the big Sign 
up for Free link and complete the registration 

form. It doesn’t take very long. Once you’re logged in, 
click on the Create a new list link. Give the list a name 
and press the Create this list button.

2 Next, add items to the list. Enter an item in the 
box and click Add this item. When you’ve done 

that, click on Close to hide this box. To access it again, 
if you want to add an item at a later date, click on the 
Add another item link. 

When you’ve completed an item on your list, 
tick the box next to it. The item disappears from 
the main to-do list at the top of the page and re-
appears in smaller letters underneath. Should you 
decide later that you haven’t completed that item, 
you can return it to the main to-do list by removing 
the tick from its box.

3 A title on its own won’t give much information 
about your to-do list, especially if you have half 

a dozen of them. Click Edit and enter more detail 
about the purpose of the task to which the list is 
related in the Description/Notes box. Click Save this 
list. If you’ve finished with a list and want to remove 

HOW TO…
Create a to-do list online
When you’ve got several tasks to do, it’s easy to get stressed. Online to-do 
lists can keep your blood pressure down and productivity up

PRODUCTIVITY
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HOW TO…
Send large attachments
Large, bulky attachments may exceed the recipient’s 
mailbox allowance. It’s easier to upload large files to 
the internet and send a link to the recipient. Mail Big 
File (www.mailbigfile.com) will do this for you. 
Alternatively, you can use file transfer protocol 
(FTP). Your ISP may give you an FTP client for 
uploading your webpages. Otherwise, use Internet 

HOW TO…
Manage your email
Keeping email manageable means keeping the inbox 
tidy. In OE, go to Tools, Options, Maintenance, Clean 
Up Now. To get rid of old messages, click Find on the 
toolbar and enter a date in the Received Before box. 
Backing up OE isn’t easy, but there is a software 
add-on that simplifies the process. Download 
OEQuick Backup 1.3 from www.softwarepatch.com.

In Thunderbird, use your profile folder to copy 
messages, contacts and other settings such as filters. 
Exit Thunderbird. In Windows XP, click Start, Run. 
Enter %AppData% and press OK. This takes you 
straight to the Application Data folder, rather than 
having to go through Documents and Settings to 
find it. Double-click on Thunderbird, then Profiles. 
You’ll find your profile folder in there. Highlight 
it, select Copy from the Edit menu and paste to 
any location. To restore the backup, make sure 
Thunderbird is closed. Click Start, Run, enter 
%AppData% and double-click on the Thunderbird 
folder. Open the Profiles.Ini folder in Notepad (Start, 
Programs, Accessories). Change the Path= line to the 
new location. Change IsRelative=1 to IsRelative=0.

Explorer or download a 
free FTP client from the 
internet or the toolkit on 
our cover DVD. Upload the 
file to your website, then 
email the link to the recipient. Details such as the 
address for the FTP server can be supplied by your ISP. 

HOW TO…
Close and re-open 
Hotmail accounts
If you don’t use your free Hotmail account for 90 
days, Microsoft will delete it and all the emails it 
contains. Your username will also be up for grabs. If 
you want to keep this, it is important to remember 
to use the account now and again, and sign in at 
least once every 10 days. However, it can also be 
handy to shut down your account now and again, 
as all messages sent to the account will be bounced 
back to the sender, hopefully removing you from a 
number of email spam lists as an inactive account. 
It is possible to do this, and keep your username 
reserved, provided you reactivate the account within 
30 days. Make sure you save any emails you want 
to keep as this will also delete all messages in the 
account. Log into your email account, then go to 
www.hotmail.msn.com/cgi-bin/accountclose and 
click on Close my account. To reactivate the 
account, you just need to sign in again.

T emplates for CVs are available in Microsoft 
Word, but what if you have a different word 
processor or you want something that looks a 

little different? You could try building one yourself 
from scratch, but that could take a considerable 
amount of time and effort. 

Fortunately, however, there is another option. 
The government agency Learn Direct has an online 
CV builder at http://83.138.168.192 that anyone can 
use. Best of all, you can store a copy online. This way, 
no matter what happens to your computer you’ll 
always have a backup available.

1 Click on the Build my CV link on the opening 
page of the website. In the next screen, click 

on the ‘CV builder tool’ link. Then click on Log in to 
secure site. 

We don’t have a username yet, so click Register 
here. Fill in the form, and when you’ve finished, click 
on the CV Builder Tool link on the left-hand side of 
the page. Press the Start button.

2 Fill in your details as requested. For helpful 
advice, click on a question in the panel and the 

answer will appear below it. You can move back and 
forwards along the 12 steps in the CV builder by 
clicking on one of the numbered links at the bottom 
of the page. If you’re logged in you won’t lose any of 
your information. 

The site also has a spellchecker and the button for 
this is on the bottom left of most pages.

3 When you get to the last screen in the CV 
builder, click View my CV. You can then save the 

finished article to your hard disk. 
The document is plain and simply laid out. If you 

want to add a bit of pizzazz to your CV, click the 
Templates link on the left-hand side of the page. 
Choose one you like and download it to your 
computer. You can then transfer your details to 
the new layout.

HOW TO…
Build a CV online
Our step-by-step guide explains how to create the perfect curriculum vitae 
so you’re always prepared

CV BUILDER TOOL

1

3

2

www.mailbigfile.com
www.softwarepatch.com
www.hotmail.msn.com/cgi-bin/accountclose
http://83.138.168.192
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HOW TO…
Download mail to one inbox
Most of us have more than one email address; at 
the very least, you’ll have a free webmail address 
and an email account from your internet service 
provider. You can download all messages from your 
accounts to your computer, as long as they support 
POP. Google Mail makes this easy to set up. Click 
on Settings, Forwarding and POP. Select the option 
to Enable POP and click on the Configuration 
instructions link. From here, you can obtain 
step-by-step instructions for setting this up 
with any email client.

Your messages can be downloaded from 
paid-for Hotmail accounts into Outlook Explorer. Go 
to Tools, Accounts, Add, Mail in order to start the 
Internet Connection wizard. If your Hotmail account 

HOW TO…
Bookmark email 
addresses
Try this time-saving trick if there are email 
addresses to which you send messages frequently. 
Create a bookmark or favourites link to any Hotmail 
page. Click Add and give it a name such as ‘Send 
Mail to Joe Bloggs’. Then right-click on its link in the 
Favourites pane or Bookmarks list if you’re using 
Firefox, and select Properties. Change the website 
address to http://hotmail.msn.com/cgi-bin/com 
pose?mailto=1&to=[Email Address], where [Email 
Address] is the address of the person to whom you’ll 
send emails, such as http://hotmail.msn. com/cgi-
bin/compose?mailto=1&to=joe@bloggs.com. 
Provided you’re 
logged into Hotmail, 
clicking on this link 
opens a blank 
message composition 
page with this email 
address already 
entered for you.

is a free one, you’ll need to use an add-on program 
such as FreePOPS (www.freepops.org/en).

HOW TO…
Forward mail
Forward mail from your Google Mail account to 
multiple accounts automatically. Click on Settings 
in the top right-hand corner, then on Forwarding 
and POP. Select Forward a copy of incoming email 
to. In the first box, enter the name of the account 
to which you want mail sent. The second box 
decides what happens to the message in Google 
Mail. For example, Archive Google Mail’s Copy will 
mark it as read and move it into the archive. Click 
‘Create a filter’ to selectively move email messages 
to more than one account.

▲ Google Mail makes it particularly easy to download 
messages to your PC

HINTS & TIPS

HOW TO…
Create individual 
accounts on a PC
If there’s only one computer in your house and 
everyone uses it, you can keep emails separate 
and private by setting up individual email identities. 
There are two processes for this: one for you, one 
for the other users. You’ll also need some technical 
details, but if you don’t still have these from when 
you first set up your email account, your ISP can 
provide them. Select File, Identities, Add New 
Identity. Type a name and tick the Require a 
Password box. For you, select File, Identities, Manage 
Identities. Click Main Identity and then Properties. 
To change users, go to File, Switch Identity.

HOW TO…
Use mail rules
Mail rules allow you to move incoming messages 
straight to a folder, to the bin or to another email 
address, reply automatically, and more. In OE, go to 
Tools, Message Rules, Mail. In the dialog box that 
appears, select the condition and action for your 
rule. For example, select the ‘Where the from line 
contains people’ option. In the third box, labelled 
Rule Description, click ‘contains people’. In the next 
box enter the email addresses of the people to 
whom the rule will apply. Continue through the 
second box to finish the rule. In Outlook 2003, go 
to Tools, Rules and Alerts, New Rule button. With 
Outlook 2000, select Tools, Rules Wizard, New. In 

HOW TO…
Change your name
Have a bit of fun and change the name that appears 
in the From line of emails that you send. Log into 
your Hotmail account and click Options in the top 
right-hand corner. Then select Personal from the 
menu on the left and click My Profile. Change the 
First Name and Last Name boxes and click Save.

Google Mail, click Create a Filter and follow the 
instructions. For Hotmail, click Options, Mail, Custom 
Replies, New Filter. In Thunderbird, select Tools, 
Message filters, New. You can add a number of criteria 
and actions to a filter just by pressing the + button. 
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www.freepops.org/en
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Your camera adjusts focus, aperture, exposure 
and sensitivity automatically to get a decent picture. 
However, you can intervene to make it look the way 
you want. Let’s start with the obvious. Focusing 
means adjusting the lens according to how far away 
something is. But which something? Autofocus 
usually goes for whatever is in the middle of the 
frame. If your subject isn’t, it may be out of focus 
while the background is sharp. To prevent this, first 
point the camera straight at the subject. Press the 
shutter button halfway; you should feel this, and a 
light may come on. Focus is now locked. Holding 
the button, move the camera to frame the shot as 
you want (without changing distance), then press 
the button fully to take the picture. Even centred 
subjects can be let down by multipoint autofocus, 
which looks at the whole scene. Check the 
instructions for a single-point option.

A half-press usually locks exposure, too. If a 
landscape comes out dark because the 
camera is exposing for the bright sky, 
point at a dark area first. If the sky 
comes out white, point at a brighter 
area next time to reduce exposure.

Most digital cameras have a time 
lag between pressing the button and 
the picture being taken. To reduce this, 
preset the focus by half-pressing or by 
selecting a fixed focus option: one 
metre, three metres or infinity 
(landscape). Normally, a camera won’t 
focus correctly at much less than a 
metre. For close-ups, use the Macro 
mode, which is usually indicated by a 
picture of a flower. This should focus 
down to a few centimetres. Wide angle 
(no zoom) will get closest.

FIELD TRIP
When shooting an object or person, 
you want it to stand out in focus while 

 M odern cameras help you get a usable picture 
every time, but you can create better shots 
with a bit of extra know-how.

The job of a camera is to focus light on to film 
or, with a digital camera, a light-sensing chip. Light 
enters the lens (actually an array of lenses) and travels 
through a hole, the aperture, which can be widened or 
narrowed. The light strikes the film only when the 
shutter is opened briefly. This is triggered when you 
press the shutter-release button to take a picture. The 
length of time it stays open – the shutter speed – 
governs the total amount of light collected, the 
exposure. The recorded image starts off being black 
and gets progressively lighter while exposed. How fast 
it lightens depends on the sensitivity or speed of the 
film, rated from around ISO 150 (slow) to ISO 1,600 
and beyond (fast). The sensitivity of a light sensor can 
be adjusted, but faster generally means a grainier 
image.

everything behind it is blurred. This is known as a 
small depth of field. Compact cameras give a large 
depth of field by default, which is good for big scenes 
but gives a characteristically amateurish look to 
portrait and detail shots. To reduce it, use a larger 
aperture, setting a faster shutter speed to keep the 
exposure correct. Your camera will do this 
automatically if you select Portrait mode.

Most cameras have several of these program or 
scene modes for different purposes. The Sports setting 
ensures the fastest shutter speed, freezing action. 
Aperture priority (Av or A) and shutter priority (Tv 
or S) modes let you fix one setting manually – for 
example, to control depth of field when you’re using 
a tripod and don’t have to worry about camera shake. 
The camera will balance out the other setting to 
correct the exposure.

Finally, always think about framing your shot. For 
a portrait, fill the frame with your subject, not by 
going too close – the wide angle will give an 
unflattering fishbowl effect – but by using zoom. For 
a scene or still life, think about the two-dimensional 
composition. The ‘rule of thirds’ is handy here (see 
the screen opposite). Include elements at different 

HOW TO… 
Take a great digital photo
Microsoft’s Flash Drive Manager can help you get more out of your portable 
storage devices. We show you how to use this useful free utility

distances to give the picture depth. If you’re shooting 
straight, make it truly straight; check the horizon or 
the verticals of buildings. Alternatively, try wild angles 
for high-impact shots. Instead of shooting from eye 
level, hold the camera at waist height, above your 
head, or on the floor for a worm’s eye view.

▲ The job of commercial photographers is often to 
make the mundane look exciting. Look for angles that 
make lines and planes divide the frame and lead the 
eye across or into the scene

▲ It can be hard to get depth of field effects with a 
consumer camera. Try blurring the foreground rather 
than the background, shooting through or past very 
close objects

▲ Wide angle plus close-up flash equals portrait 
disaster. Instead use natural light, a wide aperture for 
shallow depth of field, and zoom for more flattering 
geometry. Shoot from slightly above the face

▲ The ‘rule of thirds’ is a useful trick to help compose shots. Imagine the 
frame is divided into a 3x3 grid. Frame your shot so one or more key 
elements lie not in the squares themselves, but at corners of the central 
square, where the gridlines cross, giving you four points

DIGITAL PHOTOGRAPHY DIGITAL PHOTOGRAPHY
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Small improvements to your digital photographs can make a huge difference 
to their quality. Your image editor’s Unsharp Mask tool can help

S harpening is an obvious solution if a 
photograph is slightly soft (out of focus). More 
importantly, there are technical reasons to 

apply sharpening. First, printing an image, especially 
on a commercial press, makes it fuzzier. Second, the 
smaller you display or print an image, the less sharp it 
looks. Sharpening can compensate for these effects.

Sharpening works by increasing the contrast 
between neighbouring pixels, making edges more 
distinct. Ignore the basic Sharpen command in 
your image editor and use the professional version, 
Unsharp Mask. This sharpens only where there’s 
already a certain level of contrast, crisping up edges 
without exaggerating unwanted detail such as dust 
and skin pores. This level is set by the Threshold 
control. You can also increase the radius of the 
mask to handle images that are very soft or have 
been scaled up.

In the Unsharp Mask dialog box, try Radius 1 
pixel, Amount 100%, Threshold 4. Zoom the preview 
to 100% size to judge the results by eye. If there’s 
no visible improvement, increase the Radius. Try 1.5, 
2 or maybe 3; you’ll rarely need more. If edges are 
over-sharpened, giving a halo effect, drop the Amount 
to 70% and if necessary reduce the Radius. If edges 
look good but other areas become speckled, increase 
the Threshold.

HOW TO…
Sharpen an image

IMAGE EDITING

Combine sharpening with any down-sampling 
operation. Before reducing the pixel dimensions of a 
large photograph, sharpen it using Unsharp Mask. If 
it’s for printing, use slightly more aggressive settings. 
When you use Resize, see if the new dimensions for 
your required physical size are less than half the 
original. If so, resample to an intermediate size first, 
say 70%, sharpen again, then resample to the final 
size. A big reduction might take several steps. This 
ensures the final small image still looks sharp.

▲ The Unsharp Mask filter isn’t exactly intuitive, but it 
gives you the controls you need to get the best result 
from sharpening with each image

▲ Unsharp Mask can bring out the detail in a slightly soft photo (left) and help ensure it looks crisp when it’s printed 
(centre). Don’t overdo the sharpening, though, because you’ll end up spoiling the image (right)

A n image-editing program offers tone and 
colour adjustments ranging from one-click 
automatic corrections to more complex tools. 

Professionals use all kinds of know-how to give 
images maximum polish and impact. Here are some 
basics you can use again and again.

One common problem is incorrect white balance. 
Your camera automatically compensates for white 
balance, but not always correctly. To help spot 
problems, look at a well-balanced picture and then at 
your photo. Look for all the colours of the rainbow; 
are the reds red, the yellows yellow, the blues blue?

If the colour doesn’t seem right, there are various 
ways to correct the problem. Some programs offer a 
colour temperature slider; adjust this, and see if it 
helps. Alternatively, use grey point correction. In 
Photoshop Elements, for example, press Ctrl-L to open 
the Levels dialog box. Click on the grey eyedropper on 
the right. Click on something in the photo that should 
be grey – that is, neutral in colour. The whole image 
will update to make it so. Try different spots until the 
result looks right.

Sometimes an image is well balanced but looks 
flat. There are two standard techniques for an instant 
boost. The first uses Levels. Open the Levels dialog box 
and drag the black and white sliders inwards from the 
end of the scale. This increases contrast more 
effectively than the Contrast command, a crude tool 
that’s best avoided. If the image gets too light or dark 
overall, drag the grey slider (also known as ‘gamma’) 
left or right to correct this. 

The second technique uses the Curves control, 
missing from Photoshop Elements but available in 
other image editors such as Corel Paint Shop Pro. 
Open this (in Paint Shop, it’s under Brightness and 
Contrast on the Adjust menu), and you’ll see a 
diagonal line representing the graduation from dark to 
light values within the image. Click on this to add a 
point, which you can then drag to curve the line. Add 
two points and bend the curve into an S shape. This 
makes shadows deeper and highlights brighter.

HOW TO… 
Correct colour tones
Using an image editor to adjust your digital photographs is a useful skill. 
Here we give you some tips on making your snaps picture perfect

▲ Use grey point correction to fix images with 
unsatisfactory white balance

▲ To boost contrast, don’t use the Contrast command; 
levels works better

▲ You can apply an S-curve to add impact to a 
dull-looking photo

IMAGE EDITING
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background. There are three Lasso tools in Elements, 
and they share the same button in the Toolbox on the 
left-hand side of the screen.

The standard Lasso tool isn’t much use here 
because it’s impossible to follow a precise outline 
closely enough without mistakes and wobbles. The 
second option, the Magnetic Lasso, can follow 
outlines automatically, but it relies on clear tonal 
differences between the object and its background. 
Without that, it becomes diffi cult, darting off 
unexpectedly in different directions. The Polygonal 
Lasso tool enables you to build up selections with 
small straight-line sections. Each time you click the 
mouse button, another section is added. This is ideal 
for the outline of the car.

Using this tool, we’ve traced around the rear 
wheel arch and part of the car’s roof, then cut across 
the background and back to the starting point to 
close up the selection. Pressing the Delete key 
removes that section of the top layer, showing the 
background layer below.

4 We’ve gone round the rest of the car’s outline, 
selecting small sections and deleting them. This 

is better than attempting to select the whole outline 
in one go because mistakes are too easy to make and 
– if you’ve spent several minutes following the outline 
precisely – very frustrating to put right. There’s still 
work to be done, though. Areas of background need to 
be deleted and the background itself looks a little low 
in relation to the position of the car.

5 Get rid of the unwanted 
background areas above the car 

and to the sides by using the Eraser 
tool, which can be found in the Toolbox 
on the left of the screen. When the 
Eraser tool is selected, the Options bar 
shows a series of brush options including 
a Size pop-up. Choosing a larger size 

enables you to delete larger areas more 

 P hotoshop Elements is an excellent program, 
not just for enhancing your photos but also 
for combining them into seamless photo 

montages. If you want to superimpose shots of your 
friends against a tropical sunset or add the head of 
a chimpanzee to the body of your mother-in-law, 
all you need is some patience and skill and the 
correct software program.

Here we’ve used Photoshop Elements 5 
(www.adobe.com/uk/products). However, these 
techniques also work with previous versions of 
Elements. In our example, we’re superimposing 
a sports car in a car park on to a more attractive 
woodland scene.

1 To combine two photos, you need to open 
them both in Elements. They will appear as 

thumbnail images in the Photo Bin running across the 
bottom of the screen. Select the image you want to 
use as the background by clicking its thumbnail. It 
should now appear in the main window. In our 
example, this is the photo of the tree.

Click on the image you want to superimpose on 
it from the Photo Bin – in our example, this is the 
car – and drag the photo on to the main window. 
It’s added as a new layer, which covers up the 
background image.

2 The Layers palette in the Palette Bin to the right 
of the screen shows that the image consists of 

two separate layers: the original Background layer and 
the photo of a car that 
we dragged on to it. If you can’t see the 
Layers palette, go to Windows, Layers 
to display it. Each layer is shown as a 
thumbnail image in the Layers palette. 
You need to click on a layer to select 
it before you can start editing it.

3 Next, choose the best selection 
tool for deleting the unwanted 

4

2

3

1

quickly. The next part – moving the background up a 
little – requires an extra step. Background layers (the 
base layer in a composite image such as this one) 
can’t be moved. You need 
to double-click the layer’s thumbnail in the Layers 
palette to promote it to a full layer. You’ll be 
prompted to choose a name, but you can leave it set 
to Layer 0 to save time. The layer can be dragged up 
slightly using the Move tool in the Toolbox.

65

HOW TO…
Combine photos
You can join photos seamlessly in Photoshop Elements using just layers, 
the selection tools and the Eraser tool. Here’s how to mix and match

6 At the moment, there’s a sharp join between 
the grass in the car layer and the autumn leaves 

in the image below. It’s not possible to cut around 
each blade of grass, but there is another solution to 
the problem. By going back to the Eraser tool and 
choosing a large, soft brush size from the Options 
bar (Airbrush Soft Round 300), we can smoothly blend 
the two layers so that they appear to merge into each 
other naturally.

PHOTOSHOP ELEMENTS PHOTOSHOP ELEMENTS

a Size pop-up. Choosing a 
enables you to delete larger areas more

DID YOU KNOW?
You can hide the Photo Bin and Palette Bin 
simply by clicking the arrows at the bottom left and bottom right of the screen

BEFORE AFTER
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The more dots you pack in each inch, the smaller, 
more closely spaced they’ll be, and the better your 
eye will be fooled into seeing a continuous image. At 
arm’s-length reading distance, 300dpi is good enough. 
Further away, such as on a large poster that’s across a 
room, 100dpi or even less may be fine.

CHECKS AND BALANCES
To check the pixel dimensions of a digital photograph, 
open it in your image-editing program and go to the 
Image Size command. (You’ll get a similar dialog box 
when creating a new image from scratch.) This will 
also show a physical size and a resolution in dpi. 
Remember, the pixel dimensions are real; the image 
consists of that number of pixels. The physical size 
and resolution are just nominal values stored for 
your convenience. Make sure the Resample option 
is unticked, then enter the physical size at which you 

want to print the photo, choosing 
inches or centimetres from the 
menu. The resolution updates 
automatically to show you how 
many dots per inch you’ll get 
at this size.

As long as it comes out larger 
than 300dpi, you’re fine. If it’s way 
over, though, consider downsizing 
the image. It will take up less 
memory and print faster, and you 
can make it look sharper. If, 
however, you get significantly less 
than 300dpi, you can resize the 
image upwards, making it bigger. 
This won’t make it look perfect at 
the required size, but 
it will get blurry rather than 
pixelated, which looks better.

To change the pixel 
dimensions up or down, tick 
Resample, then enter 300 into 
the Resolution box (keeping the 

 R esolution is a simple concept that somehow 
gets everyone confused. That’s partly because 
the term is used loosely. Any bitmap image 

consists of a grid of dots, or pixels. A 5-megapixel 
digital photograph might contain 2,560x1,920 pixels, 
so you can say that it has a resolution of 2,560x1,920. 
Ask an expert what resolution you need to print a 
good-quality photograph, however, and they’ll tell 
you 300 dots per inch, or 300dpi. How do those 
figures fit together?

The number of pixels in an image is more properly 
termed its pixel dimensions. Pixel dimensions are 
connected to resolution (dpi) by a third factor: 
physical size. Let’s say you print your 2,560x1,920 
pixel image at A4 size. That’s 297mm high, or 11.7in. 
You can work out what resolution you’ll get; 2,560 
divided by 11.7 equals 219 dots per inch. Not quite 
300dpi, but adequate.

physical size set to what you want). The software 
uses interpolation to re-create the image using this 
number of pixels. Interpolation is where, to re-create 
an image using a different number of pixels, the 
software has to average the colour values of 
neighbouring pixels so it can replace several pixels 
with one, making the image smaller, or insert new 
pixels between existing ones, making it larger. There 
are usually several different methods from which you 
can choose; Bicubic is normally best. This cannot be 
reversed later without losing quality, so keep another 
copy of your original image file.

A pixel’s colour is usually defined as amounts of 
red, green and blue (RGB), the primary colours of light. 
Each of these is stored as eight bits (binary digits), 
representing the numbers from zero to 255. Hence 
the term 24-bit colour (3x8=24), also known as true 
colour, because the total of 256x256x256=16.7 
million colours is about as many as the human eye 
can distinguish. When you apply adjustments to an 
image in software, some colour detail is often lost. 

HOW TO… 
Understand resolution
Resolution is a term often used in computing but it’s easy to get it wrong 
if you’re not sure what it refers to. We take you through the basics

Starting with more data helps ensure that what is left 
is never visibly degraded, and so images are 
sometimes stored with 16 bits per colour channel, 
giving a total of 48 bits. Only more advanced 
software can handle this.

PRIMARY SCHOOL
An alternative colour format is CMYK, based on the 
primary colours used for printing: cyan (sky blue), 
magenta (hot pink), yellow and black. Few consumer 
graphics programs support CMYK, but you don’t often 
need it these days anyway.

Finally, individual colours can be specified as 
Pantone numbers. A commercial printer will look 
up these in a reference guide and mix the exact ink 
to match. It’s tricky to incorporate Pantone colours 
into images, but you can use them as ‘spot’ colours 
in DTP layouts if you arrange this with your printer. 
They’re also used to specify the solid colours in which 
vector graphics can be screen-printed on to T-shirts, 
mugs and so on.

▲ At 300dpi (top, left), a printed image will look sharp and clear. Using 200dpi (top, right) will give lower quality, 
but at a glance you might not notice the difference. However, 100dpi (above left) is too low for documents to be 
viewed at close quarters, and below this (above right) pixels are visible

▲ Use the Image Size controls to see which resolution you’ll get at a certain 
size (or vice versa) or, by ticking Resample, to change the pixel dimensions. 
‘Bicubic’ refers to the interpolation method used

RESOLUTION RESOLUTION
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right. Click on the right-hand Stop on the 
Transparency scale, which is located below the 
Gradient scale, and type 0 (zero) into the Opacity box 
on the left. Set Location to 38. Click the left-hand 
Transparency Stop and set its Location to 36. Its 
Opacity box will be set to 100. Click Close, and when 
asked if you want to save your changes click Yes. Click 
OK in the Material Properties dialog box.

5 Select the Ellipse Vector Shape tool, the third of 
the pop-out icons on the fourth button from 

last in the main toolbox, or press the Q key. In the 
Options toolbar, click the circle icon under Mode and 
tick Create On Vector. Holding the Ctrl key to draw 
from the centre, click at horizon level on one side of 

 Y ou can’t always rely on the weather to brighten 
up your photos. A rainbow can make a grey sky 
more cheerful, and adding one in your image 

editor is much more convenient than capturing one 
with your camera. Here’s how to do it in Corel Paint 
Shop Pro X. If you have other software, the method 
will differ. Users of Photoshop Elements should refer 
to the ‘At a glance’ box opposite.

1 Start Corel Paint Shop Pro X and open your 
photo. Click on the Background and Fill 

Properties swatch at the top right of the Materials 
palette. If you can’t see the palette, select it from 
Palettes on the View menu. In the Material Properties 
dialog box, click on the Gradient tab. Under Style 
select the third option, Sunburst. Click on the triangle 
to the right of the swatch above this to show a list of 
presets and choose Rainbow.

2 This gradient has the seven colours of the 
spectrum, but the wrong way round. Tick the 

box next to Invert to switch them. Then click Edit. In 
the Gradient Editor, click Save As and enter a new 
name such as ‘My rainbow’. Check the Gradient scale. 
Each colour has a Stop you can move left or right.

3 Not all the gradient will be visible when you 
apply it to a circle; in Paint Shop Pro, only about 

70 per cent appears. With Invert, this is the last 70 per 
cent on the scale. So move your fi rst colour, red, to 
the 30 per cent position. Either drag the red Stop until 
the Location box shows 30% or click on 
the Stop and type 30 into the box. Move the other 
colours to follow on as closely as possible. Again, you 
can click on each Stop then enter the next Location: 
31, 32 and so on. Keep the colours in the correct 
order: red, orange, yellow, green, blue, indigo, violet.

4 You should end up with violet at 36 per cent. If 
you have any Stops you don’t need, drag them 

off the scale. Finally, make the gradient fade off at the 

4

2

3

1

the photo. Drag up and across to draw a large circle. 
Click Edit, Undo, or press Ctrl-Z, and redraw as 
necessary to get it looking right. You may need to 
zoom out by rolling the mouse wheel.

In the Layers palette (also accessible from View, 
Palettes) your circle’s layer, Vector 1, is highlighted. 
Using the controls above this, change its blending 
mode from Normal to Soft Light and reduce its 
opacity to 50 per cent.  Then go to Adjust, Blur, 

65

HOW TO…
Paint a rainbow
If you’re under the weather, there’s an easy way to put some colour in your 
day: just use Corel Paint Shop Pro to perk up the dreariest skyline instantly

Gaussian Blur. Click OK to convert the vector shape to 
a normal layer; its name changes to Raster 1. Set 
Radius to around 12 and click OK.

6 Finally, remove the unwanted part of the 
rainbow. Choose the Selection tool, the third 

icon in the toolbox, or press S. Set the Selection type 
to Rectangular. Draw around the lower part of the 
photo and press Delete. 

COREL PAINT SHOP PRO COREL PAINT SHOP PRO

PHOTOSHOP GRADIENTSAT A GLANCE
■  In Photoshop Elements 4, gradients can be drawn directly on an image using the Gradient tool. Select this from the main toolbox, or press G, then click on the gradient swatch in the Options toolbar. Choose the Default set of gradients from the pop-up menu. Pick the penultimate swatch, Transparent Rainbow.

■  Click Edit to adjust the gradient. Leaving the red Stop where it is, drag the sliders to bunch up the other colours. Transparency is controlled by the white, black and grey Opacity Stops; bunch these up similarly at each end of your narrow spectrum. Click OK. Under Options, select Radial Gradient and tick Reverse. Transparency should also be ticked.
■ Add a new layer by pressing Shift-Ctrl-N. In the Layers palette, change its mode from Normal to Soft Light. With the Gradient tool active, drag to draw your rainbow, as in Step 5. Remove the unwanted part, as in Step 6.

BEFORE AFTER
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key, click on the circle and then drag it 
slightly up towards the top of the 
page. The cursor shows a Copy 
symbol. Release the mouse button to 
create the copy, almost exactly on top 
of the original, then change it to White 
using the Fill tab. Drag the square 

handle at the bottom centre to squash 
the circle.

3 To draw the coffee inside the cup, think 
creatively. If you click the QuickShapes icon in 

the toolbox again, you’ll see that one of the options is 
a spiral. Choose this, then click and drag over the top 
of your squashed circle. It doesn’t matter for now if 
the size and position aren’t exactly right. 

Above and below your spiral are its QuickShape 
‘nodes’. Drag the top one all the way to the left for a 
single spiral, then drag the bottom one a little way to 
reduce the number of turns.

4 To position the spiral, switch back from the 
Node tool to the main Pointer tool at the 

top of the toolbox. Resize the shape by dragging its 
handles and move it around either by dragging or by 
nudging it with the cursor keys. Position it slightly 
lower than the white ellipse, because the coffee would 
be below the rim. 

Next, draw the cup’s handle. From the 
QuickShapes, choose QuickDonut. Draw 
this on the side of the cup, then adjust its nodes. 
Drag the left one to the top so there’s no break 
in the ring, then move the top one to adjust the 
hole in the middle.

5 To give the handle volume, add a highlight. 
Using the Pointer, hold down the Ctrl key while 

you drag (in other words, Ctrl-drag) the ring to copy 
it, then fi ll it White, as in Step 2. Drag its bottom-left 
handle to make it slightly smaller and off-centre. Then 
Ctrl-drag it downwards a little to make another copy 

 Image-editing software is great for 
everything from retouching photos to 
creating your own masterpiece. However, 

it’s not quite as effective when you need 
clean, simple graphics that can be displayed 
and printed at any size, a common 
requirement for business graphics and 
corporate identity. The right tool for this 
job is vector-drawing software.

Many people are put off vector drawing by 
bezier curves. Mastering these is essential for 
professional designers. However, it is possible to 
create effective graphics without using beziers or 
any other advanced features. In this article, we 
are going to show you how to draw a logo using 
DrawPlus 4, which is free to download from 
www.freeserifsoftware.com.

 Even though your picture will be simplifi ed and 
stylised, it should convey the way an object looks, not 
a diagram or symbolic representation of it. Have the 
object, or a photo of it, in front of you. View it from a 
three-quarter angle, not straight on. 

1 Run DrawPlus 4 and click on Create a Drawing, 
Next, Finish. Zoom in a bit by clicking three 

times on the magnifying glass with a plus sign at the 
bottom left. From the toolbox on the left, click on the 
fi fth icon to pop out a choice of QuickShapes. 

We’re going to draw a coffee cup, so our main 
shape will be a circle. Choose the second icon, 
QuickEllipse. In the Fill tab on the right, set the 
colour to Burgundy. In the Line tab, choose None from 
the fi rst pop-up menu. 

Click and drag on your blank page to draw 
the shape. Hold down the Ctrl key to make a 
perfect circle.

2 A key technique is to use one shape to mask 
another. To create the rim of the coffee cup, as 

if seen from slightly above, use a second circle copied 
from the one you just drew. Holding down the Ctrl 

4

2

3

1

and fi ll this with the colour Burgundy. The second 
copy masks the fi rst, leaving a half-moon highlight. 
Reposition the shapes as necessary.

6 You then need to Ctrl-drag your fi rst circle 
downwards to make the saucer and drag its 

side handles to enlarge it. To convey the shape of the 
saucer, add a highlight using two copies, as for the cup 
handle. You’ll need to make your shapes overlap in the 

65

HOW TO…
Create a logo
To create precise drawings with accurate shading, you need a vector-drawing 
program. Here’s how to make a cup of coffee logo with Serif’s DrawPlus 4

right order: to put the saucer behind the cup, for 
example, use Arrange, Order Objects, Back One. Add 
the base of the saucer using smaller White and 
Burgundy ellipses. 

When your drawing is fi nished, press Ctrl-A to 
select all the shapes, then Ctrl-G to group them. You 
can now resize or reposition the whole drawing using 
the Pointer. The vector shapes will look perfectly 
smooth at any size. 

DRAWPLUS 4 DRAWPLUS 4

handle at the bottom centre to squash 
the circle.

EXPERT TIP
Save your drawing as a DrawPlus .dpp fi le 
for future editing, and export it as a JPEG for use in other software.
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artwork as small or large as you like without any 
image-quality issues.

FONT OF KNOWLEDGE
The most common use for vector graphics is one that 
might not be obvious: displaying and printing text. 
Fonts on your PC are stored as vectors, so characters 
look smooth and crisp whether they are rendered 
onscreen or printed across a giant poster. When 
you add text to a photograph in an image-editing 
program, it’s still usually stored as vectors, which can 
be scaled and edited independently of the image’s 
bitmap content. When you typeset text in a DTP 
program (or in Word), it’s also handled as vectors, 
as are any lines and boxes on your pages.

If you want to send artwork containing text to 
another user who may not have the same fonts as 
you, one way to ensure the text stays the same is to 

convert it to paths, so the character 
shapes are recorded rather than a link 
to the font. DTP programs can now 
do the same thing in a more elegant 
fashion by embedding a copy of the 
font file in the document. This works 
only within that document, and not 
with other tasks on the recipient’s PC.

GRAPHIC DETAIL
When you need to create graphics 
that may get re-used in various 
different contexts, such as a corporate 
logo, the professional approach is to 
draw them using vectors, so they can 
be reproduced easily at different sizes. 
Many bitmap image editors support 
vector shapes, which are stored on 
separate layers, like text. Although 
you still work 
on an image file with specific pixel 
dimensions, you can scale it up later 
and the vector elements will remain 

V ector shapes are described geometrically. 
Imagine that you have a piece of graph paper 
with the X and Y axes marked and numbered 

from 1 to 10. Mark points at, say, (1,5), (3,1), (7,8) 
and (9,3). Join them up with straight lines and you will 
have made an oblong. If you were then to give 
somebody else those coordinates, they could 
reproduce your oblong. It would always come out 
at the same angle, although it might be bigger or 
smaller than yours, depending on the size of their 
graph paper.

That’s pretty much how vector graphics work. You 
can draw lines, circles, polygons, and more complex 
shapes defined using bezier curves. You don’t have 
to enter the coordinates, unless you want to; just click 
and drag to draw shapes where you want. Files are 
relatively small, because all that’s stored is a group 
of coordinates, and you can view or print your 

HOW TO… 
Work with vector images
Vector graphics enable you to create professional-looking logos and make 
text look more dynamic. Here we show you how to be quick on the draw 

Bezier curve drawing is 
straightforward in principle. 
Click, move and click again to 
draw a straight line or ‘path’, or 
click and drag to create handles 
that control a smooth curve

▲ Microsoft Expression Design is a creative vector drawing program that’s 
well worth using to create distinctive graphics

smooth. Vector drawing programs take things further, 
allowing you to build up finely detailed and shaded 
illustrations. Nowadays, they incorporate bitmap 
effects, allowing things such as soft-edged shadows 
that would be hard to create using vectors.

Microsoft Expression Design is a unique vector-
drawing program that creates fluid, paint-like strokes. 

Download it as soon as you can, while it’s still 
available as a free beta, and make it your secret 
weapon for instant graphics that look as if they 
required enormous skill. 

Alternatively, you can try Creature House 
Expression, the original version, which is available 
free of charge at www.tinyurl.com/2nqxhc.

VECTOR GRAPHICS VECTOR GRAPHICS

www.tinyurl.com/2nqxhc
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2 Select the Marquee tool, fifth from the top 
in the toolbox on the left (or press M). In the 

Options bar at the top, choose the Elliptical shape, set 
Feather to 0, and tick Anti-alias. From the Mode pick 
list, choose Fixed Size. Set Width and Height to 1cm. 
Click anywhere on your page to select a 1cm circle. 
Choose Fill Selection from the Edit menu, or press 
Shift-Backspace, to bring up the Fill Layer box. Under 
Contents, choose Black. Set Normal, 100% and 
untick Preserve Transparency. Click OK to colour the 
circle black.

3 People’s eyes are about halfway up their heads, 
so centre the circle. Press Ctrl-X to cut it, Ctrl-0 

(zero) to fit the whole page in the window, then 
Ctrl-V to paste the selection into the middle. Then 
go to Image, Resize, Canvas Size. Set the Width to 
105mm (half A4) and click the middle-left Anchor 
position. Click OK.

4 You may want to save this template as a 
Photoshop (.psd) file for future use. Next, go 

to File, Open (or press Ctrl-O) and load a photo. Pick 
the Move tool from the top of the toolbox (or press 
V), click on the photo and drag it on your mask 
template. Press Ctrl-[ to send the photo’s layer behind, 
so you can see your black circle on top. Position the 
photo so half the head roughly fills the page, with the 
centre line of the face on the right edge and the eye 
lined up with the circle. Resize the photo by dragging 
a corner handle of its bounding box and, if necessary, 
rotate it by moving the mouse just off a corner to 
show a turning arrow symbol, then drag. You may need 
to zoom out by pressing Ctrl and the minus (-) symbol 
or enlarge the window to keep the handles visible.

5 Press Return or click the green tick button. Then 
cut out your half-face. Choose the Lasso tool 

from the toolbox (or press L), and in the Options bar 
choose Polygonal Lasso, the last of the three icons on 
the left. Click at the top of the face on the right edge 

 M asks are always a good party novelty, 
especially if you create them from faces 
that are relevant to the occasion. This could 

be animals, politicians and maybe even your guests – 
whatever fits the mood. Masks can go down just as 
well on a stag or hen night as they do at a child’s 
birthday party.

There are three stages to making a mask. First, you 
need to create a template with the eye holes in the 
right place. Second, you have to fit a photograph on 
to it. Third, print out and finish. Below, you can see 
how to complete the first two tasks in Photoshop 
Elements 5. Similar steps can be used in other 
image editors.

A sheet of A4 paper is large enough to fit an adult 
face on, so you’ll be able to print your image on any 
inkjet. Before cutting it out, stick the printout to a 
sheet of thick card. Ideally, use spray mount adhesive, 
available from art shops. Then carefully cut it out. We 
suggest you draw the outline using straight lines, 
which you can cut along using a craft knife and ruler.

To make the mask wearable, you could attach 
ribbon between holes on each side, level with the 
eyes. For the best results, reinforce the holes 
using eyelet pliers, which cost £2.99 from 
www.maplin.co.uk (code RM54J). Alternatively, you 
can mount your mask on a stick. Use a flat stick such 
as a large lollipop stick; you can get 20 for £2.99 from 
www.cakescookiesandcraftsshop.co.uk. Fix the stick to 
the back with strong glue or tape, overlapping it 
enough to hold the mask upright.

1 Run Photoshop Elements 5 and click Edit and 
Enhance Photos. Go to File, New, Blank File (or 

press Ctrl-N). In the New box, choose A4 from the 
Preset pick list. Make sure the Color Mode is RGB. 
Next, change the Width to the required distance 
between the eyeholes. This should be around 65mm 
for adults and 50mm for kids. Set Background 
Contents to Transparent. Click OK to make a long, tall 
page that’s transparent, indicated by a checkerboard.

4

2

3

1

of the page, release the mouse button, then move 
along the outline of the face to make a straight line. 
Click again to draw this line and continue around the 
face. Don’t try to be too precise. Finish at the bottom 
right and double-click to join the line back to the 
beginning. Zoom in by pressing Ctrl and the plus (+) 
symbol to check that the selection goes right to the 
edge of the page. Press Ctrl-Shift-I (Inverse) followed 
by Delete to remove the background.

65

HOW TO…
Make a mask
If you need a mask for a party, why not make your own? Here we show you 
how to use to Photoshop Elements to create the perfect disguise

6 Next you need to Image, Crop; this will cut 
off the unseen, unused parts of your image. You 

need to press Shift-Ctrl-E to merge the layers. Then 
go to Canvas Size as in Step 3, set Width to 210mm 
and choose the middle left Anchor position. Click OK. 
Go to Layer, Duplicate Layer and click OK in the 
dialog box. Finally, you just have to press Ctrl-A 
(Select All) and then go to Image, Rotate, Flip 
Selection Horizontal.

PHOTOSHOP ELEMENTS PHOTOSHOP ELEMENTS

www.maplin.co.uk
www.cakescookiesandcraftsshop.co.uk

